PedCath was developed in the winter of 1994 at the request of Dr. Allen Everett and others at the University of Virginia Health Sciences Center. While initially conceived 14 years earlier and attempted on one of the original Apple II computers, the processing speed and graphics power available today have enabled us to develop a powerful tool for pediatric catheterization reporting, used in the majority of congenital cath labs worldwide.

PedCath has been used continuously at the University of Virginia since January 1, 1995. It combines several important features:

1) An easy method of recording data specific to the pediatric catheterization laboratory. The program works in any cath lab, on any PC running Windows, and provides a standard set of hemodynamic calculations.

2) The definitive atlas of congenital defects. We are proud to be the only company licensed to distribute the Mullins and Mayer Atlas for electronic cath reporting. We have expanded the atlas with many new diagrams available for download.

3) A visual database of all patients having undergone cardiac catheterization.

4) A powerful, built-in drawing program for modifying diagrams to show patient-specific anatomy. The drawing program makes it easy to represent the patient’s anatomy accurately, and to add hemodynamic values and other annotations.

5) A data structure designed so that statistical summaries may be quickly and easily compiled. PedCath includes software for reporting patient groups by diagnosis, age, cath date or physician.

Acknowledgments

Dr. Allen Everett has given freely of his time to help develop PedCath. He has also provided invaluable assistance as editor of the Illustrated Field Guide to Congenital Heart Disease and Repair, the PedHeart Encyclopedia, the PedHeart Primer, PedHeart Prints and The Cove Point Congenital Heart Resource Center (www.Congenital.info). Without his generous help, none of these would have been possible.

At the University of Virginia, Scott Lim MD, Paul Matherne MD, and Howard Gutgesell MD have aided in the design of PedCath and provided technical guidance. Drs. Felice Heller, William Hammill and Naomi Gauthier provided live testing and feedback during the initial testing phase.

PedCath was tested at many institutions before you received this copy. In particular, we wish to thank:

- Dr. Donald Hagler at the Mayo Clinic
- Dr. Masato Takahashi at Children’s Hospital LA
- Dr. James Moller at the University of Minnesota
- Dr. Mark Alexander at Boston Children’s Hospital
- Dr. Gil Wernovsky and Dr. Jonathan Rome at Children’s Hospital of Philadelphia
- Dr. Ed Overholt at Oklahoma Children’s Hospital
- Dr. Michael R. Nihill, Dr. Charles E. Mullins and Dr. Ronald G. Grifka at Texas Children’s Hospital

Dr. Lee Benson at The Hospital for Sick Children (Toronto) has guided development of the optional hierarchical diagnostic codes and many other features that have been added to PedCath over the years.

We would also like to thank Dr. Charles E. Mullins and Dr. Timothy J. Bricker for their assistance in licensing the Mullins & Mayer Atlas©.

Thanks to all
**PedCath Development History & Possible Configurations**

**Stand-alone**
- Single Workstation
- Manual data entry
- PedCath³ 1995

**Cath Lab Data Capture**
- Multiple Workstations and Cath Data Capture
- Cardiology Department
- Cath Lab
- PedCath³ 1999

**Hospital-wide Multi-user**
- Patient Database
- Surgery
- I.C.U.
- PedCath⁷ 2002

**Global Data Options**
- Congenital cath labs
- Registry & Collaboration
- Regional Database
- Risk Factor Assessment
- National Reporting Tool
- Congenital Heart EMR
- PedCath 2004
Overview of Features

Over the past 10 years, PedCath has become the most widely used software for storing and reporting data from congenital cardiac catheterization procedures. While it remains simple enough to run on virtually any PC, the program is designed with the needs of physicians and other practitioners in mind. It is intended to save valuable time, while improving the accuracy, thoroughness and appearance of cath reports.

With PedCath, data entry is designed to be quick and easy. As you enter the results of a catheterization procedure, the program automatically makes standard calculations and displays the results on the screen. A calculation override feature is provided as well, allowing you complete control over every calculated value.

You may select diagnosis and intervention codes, to be stored as part of each cath record. Whether you are using the standard diagnostic code set or an optional one, you can easily select codes and then rank them in order of importance. Optional code sets are also available; current choices include the widely used codes from Boston Children’s Hospital, Toronto Hospital for Sick Children, Texas Children’s Hospital and the European Paediatric Cardiac Coding System.

Perhaps the most unusual feature of PedCath is its ability to generate, store, retrieve and print high-quality anatomical diagrams. You may select up to three diagrams for each cath. If a patient’s cath record includes more than one set of hemodynamic data, individual diagrams may be specifically associated with one or more data sets.

After selecting an appropriate diagram, you may modify it to match the patient’s anatomy by using the special, built-in drawing program. The drawing tools allow you to add text to the diagram or to insert arrows indicating the catheter course. Interventional devices are easily illustrated. Cath data can be automatically embedded or manually inserted from a table directly into the diagram. In addition, you may save the modified diagram as a template, to be used as a starting place when recording future cath data for the same patient.

The printed cath report contains all hemodynamic data, as well as hospital and patient information, the patient’s anatomical diagram, and standard calculations. The diagram and other data can be exported to disk in several standard formats, to be used by your institution’s internal information systems or directly emailed to other doctors.

The document manager allows you to generate, store and print documents with each cath record, and the image manager allows you to add angio still frames, waveforms, or any other image to your cath report.

We are always looking for ways to improve your software and enhance its usability. Please do not hesitate to get in touch with your comments and suggestions.

Scientific Software Solutions, Inc.
317 Monte Vista Avenue
Charlottesville, VA 22903

Email: support@PedHeart.com
Telephone: 434-293-7661
**PedCath License Agreement**

The software described in this document is furnished under a license agreement and may be used only in accordance with the terms of the agreement.

Thank you for purchasing software from *Scientific Software Solutions, Inc.* Our goal is to provide high-quality software for pediatric cardiologists and other subspecialties. Please read the license agreement below. We depend upon you to honor this agreement, so that we can continue to bring you software products that are useful, and a good value.

For your convenience, the CD-ROM disk for *PedCath* is not copy protected. Our license allows you to make as many backup copies of this software as you wish, to protect your investment. You are free to move the software from one computer to another, so long as there is no possibility of its being used at two institutions at one time. If you do not have the multi-user license, this software should be treated like a book, which cannot be read by two people at two different locations at the same time.

**License Conditions**
The *PedCath* Software is licensed for the exclusive use of the original purchaser ("your institution"), for use at a single location. The Software may be used on a single computer network at that location. "Use" of the Software means the loading into temporary memory (i.e. RAM) or installation into permanent memory (e.g. hard disk or other storage device) of that computer. You may make copies of the Software, solely for backup or archival purposes. The integrated Mullins & Mayer Atlas may be used for the exclusive purpose of preparing printed reports for your institution by the *PedCath* Software. Any other use of the Atlas requires written permission. You may not modify, reverse engineer, decompile, disassemble, translate or make any attempt to discover the source code of the Software, or create derivative works from the Software. You may not copy the Software or Documentation (except for back-up archival purposes).

**Copyrights and Trademarks**
*PedCath*, *PedCath3*, *PedCath7* and *PedCath Enterprise* are trademarks of Scientific Software Solutions, Inc. The *PedCath* software is a Copyright © 1994-2008 of Scientific Software Solutions, Inc. The *PedCath* User's Manual is a Copyright © 1995-2006 of Scientific Software Solutions, Inc. All rights are reserved. The *PedCath* Software ("Software") and User's Manual ("Manual") or portions thereof may not be reproduced in any form whatsoever without prior written permission (except as explicitly permitted by this License Agreement). Contact Scientific Software Solutions, Inc. 317 Monte Vista Avenue, Charlottesville, Virginia, 22903. All versions of the *PedCath* software and User's Manual are the licensed property of Scientific Software Solutions, Inc. Use of the Software and/or Atlas indicates your acceptance of the terms and conditions of this License Agreement, including but not limited to the License Conditions, Disclaimer of Warranty and Choice of Law provisions.

**Disclaimer of Warranty**
We have made every effort to verify that *PedCath* is an effective tool for preparing cath reports. To the maximum extent permitted by applicable law, *PedCath* is sold "as is", without any warranty of any kind. All warranties, either express or implied, including, but not limited to implied warranties of merchantability and fitness for a particular purpose, are DISCLAIMED. The only exception is the 60-day money back return policy.

**No Liability for Consequential Damages.**
To the maximum extent permitted by applicable law, in no event shall Software manufacturers or suppliers be liable for any damages whatsoever, including without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss, arising out of the use or inability to use the Software. The liability of Scientific Software Solutions, Inc., under the warranty set forth above shall be limited to the amount paid by the customer for the product. In no event shall Scientific Software Solutions, Inc. be liable or responsible for any problems that arise because of defects with *PedCath* or for any special, consequential, or other damages for breach of warranty.

**Choice of Law**
This Agreement shall be construed, interpreted, and governed by the laws of the State of Virginia, United States of America.
Overview and Technical Notes

**PedCath** is a Congenital Cardiac Catheterization Reporting Tool. It was designed to allow user generated comprehensive reports following a catheterization procedure in order to record the actions performed, findings made and to communicate this information with other medical personnel. Users may recall any cath report saved since the first cath was entered.

The **PedCath** database structure begins at the patient level. Each patient record can be associated with an unlimited number of cath records. Each cath record can be associated with up to three diagrams, eight sets of hemodynamic data, comments, diagnostic codes, billing codes, images and documents. In addition to being saved in the database, the report can be printed or saved as a PDF, HTML or ASCII file. Optional XML and HL7 file formats as well as FTP protocols are available.

**PedCath** is a workstation based (“fat-client”) application. The application is installed on each local machine from which you wish to access the **PedCath** data. **PedCath** is licensed as either single-user or multi-user. This refers to the number of concurrent users that may access **PedCath** at any one time. The data is in relational dBase format and each table is a unique file (*.dbf). Most tables have corresponding index files (*.nsx) and some have one or more memo files (*.smt). In addition to the database files, there are diagram files (*.pcx), image files (various image formats) and report files (various document formats). These files may reside in a directory located anywhere on the network where the local workstations have read/write privileges, or on a stand-alone PC. The amount of data required by each cath depends on the number of documents, diagrams, and images included in the cath report and, to a lesser extent, the amount of data entered by the user. Typically, each additional cath report is smaller than 500KB (excluding Image Manager items).

**PedCath** Hardware Requirements

**Operating System**

**PedCath** will operate on any 32-bit version of Windows, which includes Windows 95, 98, 2000, Windows NT 4.0, Windows XP, and Windows 7. While there are no operating system issues with Windows 95, we have found that Win95 machines, in a hospital setting, may not have the resources required to run modern applications like **PedCath** Enterprise.

**Video**

**PedCath** is designed to work best at a screen resolution of 1024x768 or more but it will function well at 800x600. Screen resolutions less than 800x600 are not supported.

**Hardware**

**Minimum specifications:** will always vary with the computer configuration, network, and other applications that may be running concurrently.

**Recommended specification:** 1 GHz or better processor, Windows 2000, XP or Windows 7 with 256M or more ram.

* **PedCath** does not support Japanese, Chinese or Cyrillic character sets under Windows 98.
Installing **PedCath**

**PedCath** requires separate installation of program and data files.

**Updating Data Files**

If you have been using **PedCath**³ or an earlier version of **PedCath**⁷, your existing data will need to be converted to the current format. Use the instructions provided with your installation CD if you are upgrading existing data.

**Installing Data Files for New Users**

Empty **PedCath** data files are provided for new users on the installation CD in the “BlankData” folder. If you are going to use the program on more than one computer, the data will need to be accessible to each workstation. This usually means setting up a data folder on a server.

New users install the empty **PedCath** data files by opening the “BlankData” folder on the CD-ROM and double-clicking PC7_Net.exe. This will create a folder called “PC7_NET.”

The default location for the PC7_NET folder will be on the C: drive, which is correct for installation on a single computer. For network installations, this folder will need to be installed on the network server. For example, if the network drive is mapped as “S:”, the location for installation of the PC7_NET directory should be changed from C: to S:.

The “PC7 Net” folder contains about 11Mb of data when first installed. Subsequent cath reports require relatively little hard disk space. Each completed cath report typically adds 250K to 500K. If you are assigning disk space to the **PedCath** data folder, 100Mb should be sufficient to store well more than one hundred cath reports.

Each workstation running the program will need to access **PedCath**’s common data files. These files, the diagrammatic atlas and other shared files are typically placed on a server. Each user must have read-write privileges to this “PC7_Net” folder on the server.

If you plan to install **PedCath** on only one computer, the data files can be placed on your local hard disk. Data can be moved to a server later, if you add additional computers.

**Installing **PedCath** Program Files (local workstations)**

You will need about 24 MB of space on each workstation for the software. This amount is in addition to what is required in the network folder.

To install **PedCath** on an individual workstation, you will need to run the install program. We provide a CD-ROM that contains the installation program. If the computer supports autorun, the installation program will begin when the CD is inserted.

In addition, we can provide a single-file executable that will install the program on the local machine when run from that machine. Some hospitals have placed this program in a subdirectory of the **PedCath** network folder and emailed links to individual users. Users click the link and the program is installed on their computer. Some anti-virus software will interfere with this method.

**Installing **PedCath** Updates (local workstations)**

**PedCath** updates are available to all users with current support on the web at [www.PedCath.com](http://www.PedCath.com). Network administrators may choose to allow users to update directly from the web, or distribute *.P7U update packets without users directly accessing the internet.
Running **PedCath** for the First Time

**Locating the data folder**

The first time you run **PedCath**, you will be asked to locate the network data folder. Click OK, then select the location of the “PC7_Net” folder. If you do not know the location of the data directory, ask your network administrator.

Notice the red light next to the ‘file found’ box. **PedCath** will check the directory you select. When the light turns green (as shown by yellow arrow, opposite), you know the proper data files have been found.

**First Login**

After the **PedCath** installation is complete and the data path is selected, log in as an administrator with the initials **SSS**.

The **SSS** password will be **Taussig** or **pedcath**.

**Adding **PedCath** users**

You will need to add personnel before adding new caths.

From the menu bar, select **Tools-Options-Administrator-Personnel** and click the **Edit Personnel** button.

(Note: you can also edit personnel by choosing **View-Personnel** from the menu bar)

Assuming you will have administrative privileges, click the **Add New** button and enter your own information in the screen provided. Make a note of the initials **PedCath** is going to use for your log in. You may change these if desired. Click OK and make sure to give yourself **Administrative** privileges. Exit and close the program.

**Initial Passwords**

**PedCath** is now set up to run with two administrative users, you and the original SSS administrator.

Log in to the program once more, but this time use your own initials.

**Initial Password for all new users will be** **Taussig**

After logging in the first time, the password must be changed.

**Removing **PedCath** users**

After logging in with your own initials and changing your password, go once again to the tools menu and select “Options…” There, select the “Administrator” tab and then select “Personnel” from the list on the left and click the “Edit Personnel” button. To remove a personnel member, select their name within the list and click the **Make Inactive** button.
Prior to Using **PedCath** for Cath Reporting

**PedCath** is initially configured with one administrative user. Additional personnel may be added by anyone with administrative privileges. If you are entering a large number of personnel at one time, note that only the display, initials, and permissions settings are required for each user and other information can be entered at a later time.

*Note: After setting up your users and at least one administrator, it is a good idea to remove the SSS Administrator from the active list.*

Other Administrative Options

It is important for the cath lab director to review the **Options** settings. There are several clinical and administrative settings that should be confirmed before entering actual case data.

**PedCath** Technical Overview

**Introduction**

**PedCath** 7 is a "networkable" desktop application. You must install **PedCath** on each computer on which you want to use it, and each running instance of **PedCath** must have read/write access to the Data Folder. The Data Folder contains the **PedCath** database files and other files (such as diagrams, images, and documents) that are linked to cath records. The Data Folder may also contain export and import files, **PedCath** update files, patient and stock diagram templates, document templates and various configuration files.

**Requirements**

**Local Computer**

**Minimum Specifications**

- Pentium III 500 MHz or equivalent processor
- 64 MB RAM
- Windows 98, NT 4.0, 2000, XP or Windows 7 operating system
- 16 MB video adapter memory, 800 x 600 resolution
- 30 MB available hard disk space

**Recommended Specifications**

- Pentium III 1 GHz or equivalent processor
- 128 MB RAM
- Windows 2000 Professional SP4, XP Professional SP2 or Windows 7 operating system
- 32 MB video adapter memory, 1024 x 768 resolution
- 100 MB available hard disk space

**File Permissions**

Each instance of **PedCath** must have read/write access to the Local Program Folder (see Appendix A). Each instance must also have read/write permissions to the Data Folder and, if you have a Direct Data Import Utility, to the Import Folder. This means that each **PedCath** user must have read/write permission to all these folders on each computer on which he/she uses **PedCath**.
Registry Permissions

Each instance of PedCath must also have read/write permission to the following Windows registry keys:

- HKEY_CURRENT_USER\Software\PedCath
- HKEY_LOCAL_MACHINE\Software\PedCath

Data Folder

The PedCath data folder is nothing more than a directory with subdirectories and files in it. PedCath does not use a database server. PedCath uses standard Windows file sharing to allow multiple installations to access the same data. Therefore, the data folder can be anywhere on the network, as long as each instance of PedCath has read/write access to it.

When PedCath is first installed, the Data Folder will be about 14 MB in size. The size each record can vary widely, depending on the number and size of diagrams, images, documents, import files and export files. A typical record is less than 100 KB, and a typical institution will add fewer than 500 records per year. If storage space is a concern, you should check the size of the Data Folder periodically for the first month or two after installation to get an idea of how quickly it grows in size.

Installing PedCath

PedCath is a desktop application and therefore you must manually install it on every computer on which you want it to run. There are two methods for installing PedCath: from the CD or from the network.

Installing from the CD

To install from the CD simply log in to the computer and insert the CD. The setup program should start automatically. If the system does not support autorun, then navigate to the CD and manually start setup.exe.

Installing from the Network

Included on your CD is a single-file setup application that you can run from the network, called pc7_setup.exe. This file is located in the Support\SingleEx\ folder. Copy this file to a place on the network that you'll be able to access from each computer where you want to install PedCath. Someone must still run this file on each computer, but this saves you having to move the CD around and enables some other options. At institutions where users are able to install software, you can simply send a link via email. Or, if you have remote desktop capabilities, this method will allow you to install PedCath from a remote computer.

Updating PedCath

The installation procedure described above is only necessary the first time PedCath is installed on a particular machine. Subsequent updates to PedCath can be installed by any PedCath user via the PedCath Update Wizard, which is installed in the Local Program Folder (see Appendix A) when you install the main PedCath application. The Update Wizard uses PedCath update files (*.p7u) to perform the update. The Update Wizard can automatically download and use the latest update file from the Web, or it can use a file on the local machine or the network. Occasionally it's required to install an update wizard/update file package (*.exe) if a new version of the Update Wizard is required to install the p7u file.

There are major and minor releases of PedCath. A major release will have a larger second number in the version number string: version 7.6.x is the next major release after version 7.5.x. All computers in the hospital must be running the same major release. So, for example, if all computers are running version 7.5.8 and someone updates one computer to version 7.6.0, then all the other instances of PedCath will be forced to update before they can access the data. All minor updates are optional. So, for example, someone may update an instance of PedCath 7.5.5 to version 7.5.8 without affecting any other instance of PedCath in any way.
**Users and Security**

**PedCath** requires all users to log in with a username and password. There are several different permission levels (see Appendix B). Only Administrators may add and edit other user records. **PedCath** ships with a single Administrator account:

Username: *SSS*
Password: ‘*taussig*’ or ‘*pedcath*’ (without quotes)

You can safely delete this user account once you've added a new Administrator. Typically, usernames are the users' initials. When a user is initially added, his or her password is set to ‘*taussig*’. An administrator may reset another user's password. This will set it to ‘*taussig*’. Anytime someone logs in with ‘*taussig*’ as his or her password, **PedCath** will force him or her to change it to something different. Neither usernames nor passwords are case sensitive.

We recommend that you make at least one regular user of **PedCath** who is somewhat computer-savvy an Administrator. At many institutions, all attending physicians and perhaps some fellows are Administrators.

**Maintenance**

We designed **PedCath** so that normal users are able to update and maintain it. Once **PedCath** is installed and running, any reasonably capable Administrator should be able to handle updates and maintenance. There is a simple Administrative Console application that's accessible via the Windows Start Menu or by running the executable directly from within the **PedCath** program folder. We recommend that you schedule regular maintenance using the feature in the Administrative Console.

**Summary**

- **PedCath** must be installed on each local computer where you want it to run. You can install it from the CD or from the network.
- Each instance of **PedCath** must have read/write privileges to:
  - The Data Folder
  - The Program Folder
  - Two keys in the Windows Registry
  - The Import Folder (if applicable)
  - The Export Folder (if applicable)
- The initial user is ‘*SSS*’ with password ‘*taussig*’ or ‘*pedcath*’.
- A new user's initial password is always ‘*taussig*’. Resetting a user's password sets it to ‘*taussig*’.
- Users with Administrator privileges can update and maintain **PedCath**.

**See Also**

**PedCath** 7 User's Manual – Using **PedCath**
Appendix A: Glossary

Administrative Console
A program that allows a PedCath Administrator to perform various administrative tasks without having to open PedCath. The Administrative Console is installed with PedCath, in the Program Folder and is accessible via the Windows start menu.

Data Export
PedCath can export data in a variety of formats, manually and/or automatically.

Data Folder
This is the folder that contains all the PedCath database files. It also contains image files, document files and various other files that are part of the PedCath data and/or are necessary for PedCath to operate properly. The Data Folder can reside anywhere on the network, as long as each running instance of PedCath has read/write access to it.

Data Import
PedCath has the ability to import data from most major hemodynamic monitoring system in use today. Please contact Scientific Software Solutions, Inc. for more information if you do not already have Data Import features enabled.

Direct Data Import Utility (see Data Import)

Export Folder
This is a folder where PedCath will save Patient Reports if the automatic export feature is enabled. PedCath will need write permission to this folder.

Import Folder
This is the folder where PedCath will expect to find files exported from your cath lab after the case. Usually, this is a permanent location on the network, but it can be any physical medium used for transporting data if necessary. PedCath must have read access to this folder, and will perform best if it also has write access to it.

Local Program Folder
This the folder into which PedCath is installed on a local machine. PedCath needs to read and write to this folder during normal operation.

Program Folder (see Local Program Folder)

Update Wizard
An application that users can use to update PedCath to the latest version over the Internet or to any version by using a PedCath update file (*.p7u). The Update Wizard is installed with PedCath, in the Program Folder and is accessible via the Windows start menu.
## Appendix B: Permission Levels

<table>
<thead>
<tr>
<th>Action</th>
<th>Admin</th>
<th>Full (Edit All)</th>
<th>Edit Case Data</th>
<th>Edit Patient Data</th>
<th>View Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter PedCath 7</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Add, Edit Patient</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Delete Patient</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add, Edit Cath Record</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Cath Record</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Personnel</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Personnel Display, Initials</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Edit Other Personnel Data</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Personnel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General (Local) Options</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>User Options</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global Options</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Administrator Options</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Add, Edit, Delete Documents</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Edit Cath Personnel List</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add, Edit, Delete Hemodynamic Data</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add, Edit, Delete Diagrams</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add, Delete Diagnoses</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add, Edit, Delete Images</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add, Edit, Delete Comments</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Cath Data</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
System Restore

It is critical that you have a regular system in place for backing up all of the data files, heart diagrams and image files associated with PedCath on a regular basis.

We recommend backing up the entire PC7_NET folder to an off-site location on a monthly basis. A monthly backup is a good way to prevent a large amount of data loss although more frequent backups would be ideal.

*Make sure you have a backup system in place NOW!!!*
Logging into **PedCath** for the first time

If you are logging into **PedCath** for the first time, the default password is *Taussig* or *pedcath*.

Once you have used this password to login, you must change it immediately, and will be prompted to do so.

If you are using a demo version of **PedCath**, there is no login screen.

Exploring the BROWSE screen

The BROWSE screen gives you a visual snapshot of every patient and every cath. Take a moment to browse through the sample patients. Clicking on a patient will update the bottom portion of the screen. Notice how **PedCath** displays patients with multiple caths (Buck Rogers) and multiple sets of hemodynamic data (Lotsa Oxygen and John Deere).
Adding a New Patient to PedCath

Click on the Add Patient button or click on the New Patient icon.

Fill in patient information as shown in the box.

Adding a Cath Report

With the patient you just entered highlighted, click the Add Cath button, or click the New Cath Report icon. This will open the Edit Cath Screen:
**Entering Case Information**

Add information about this cath in the *Case Information* box.

![Case Information](image)

**Selecting and Removing Cath Personnel**

Click on the *Add Personnel to Cath Report* icon.

You may select personnel by highlighting their names and clicking OK.

To change someone’s role, click on his or her role in the list for this cath, and use the drop down list to select a new role.

To remove personnel from a cath, click on the *Remove Personnel* icon.

Only administrators may add new personnel to the *PedCath* master list.

**Entering Hemodynamic Sets**

Go to the *Hemodynamics Sets* section of the screen (left, middle) and enter a title, “post intervention” in the box next to the “Set 1 of 1” text. Each cath may have up to eight sets of hemodynamics.

Now click on the Hemodynamics tab unless it is already open and add the cath information listed below.


**Entering Diagnosis/ Procedures**

Click on the Diagnosis and Procedures icon \(Dx\).

If asked, choose Yes to save your changes. The Diagnosis screen will be displayed.

Note: This tutorial assumes you are using the diagnostic code set shipped with the **PedCath** demo CD. If your screen has a different list on the right, you are using one of the alternative codes sets available with **PedCath**. You will still have the tree list and search capabilities described below, but the code descriptions, code numbers and category organization will be different.

A tree list of all possible codes is available in the right-hand box. The upper-left box is for diagnoses and procedures associated with this cath. The two sections in the lower left contain search tools to help you find the correct codes. You may search by code number or by text fragment.

**Text Search**

In this example, we will search by name first. Enter stent. You can see that two of the procedures you performed are listed. To place them on the selected procedures section either double click the selection or click the Add button on the right.

**Code Search**

Now search by code. In the select code box, enter 00046. DORV should pop up next to it. Click the Add button to place it in the procedures box.

**Tree List Search**

Finally, we can use the tree list to find our last two Dx. Codes. In the tree list, click on the + sign next to Surgery Procedure. Scroll down to PVR and TVR (codes 00702 and 00703). When a code has been highlighted, click on the <<Add button to add it to the list of Selected Diagnoses and Procedures.

Now highlight one of the 5 codes for this cath and use the Rank arrows to move it up and down in the list. **PedCath** allows you to set the relative importance of each diagnostic code.

Click the OK button to exit from this screen. Your selections are saved automatically.
The Diagram Manager

Click on the **Diagram Manager** icon, under the **Report Component Managers** section (upper right on the Edit Cath Report Screen).

Each cath may have up to three diagrams associated with it.

**Selecting a Heart Diagram**

Click on the **Add Diagram** icon, to view a selection of different heart diagrams.

For this patient, click on the + sign next to *Postoperative Anatomy*

Then choose

*Right Ventricle to Pulmonary Artery Conduit with Patch Closure of the Ventricular Septal Defect for Truncus Arteriosus and Right Aorta Arch*

To select this diagram for this cath, double click on the heart diagram title, which will be highlighted and underlined in blue. You can also click the **Select Diagram** button.

When you have selected your diagram, PedCath returns to the **Diagram Manager** screen.

To edit your new diagram, just click on the **Edit Diagram** icon.
Editing a Heart Diagram

**Erasing**
Choose the **Freehand Tool** icon. Next click on a medium sized line.

Now click on white to select it as a foreground color and right-click on white to also select it as a background color.

**Freehand Drawing**
With the **Freehand Tool** set to white, erase part of the Tricuspid Valve by writing over it.

Change the foreground color to black and choose a smaller line width. Sketch a prosthetic tricuspid by drawing a loop where the original valve was.

**The Blob Tool**
Click on the **Blob Tool** icon.
Select a thin line, a diagonal crisscross **Fill Style**, a transparent **Fill Mode**, a black foreground, and a red background.

Use the **Blob Tool** to draw stents in the Pulmonary artery by tracing an outline of each stent along the walls of the artery.
Undo and Erase
If you make any errors you can either use the **Undo icon** to erase the last thing you drew, use the **Freehand Tool** set to white to erase, or use the **Selection Tool** to click on the item to make a box appear around the item then press the Delete key.

Saving Diagram Templates
Because you made extensive changes to the diagram, click on the **Save Template** button to save it as a permanent template for the patient. This template will be available for any later caths for this patient.

Using Arrows
To show the path or direction of the catheter, click on the **Line Arrow Tool**. Select a line width, no **Start Arrow**, and a medium **End Arrow**.

Choose a black foreground and a white background.
Now start the arrow at the beginning of the IVC and ending it in the RA. Draw another arrow beginning in the RA and ending in the RV.

Embedding Hemodynamic Values into your Diagram
Click on the **Embed** button to insert all of the hemodynamic data into the diagram.

Your final diagram should look similar to this one. Close the Edit Diagram box, saving the patient diagram for this cath (right).
Logging In

Start PedCath as you would any Windows program: Click the Start menu, and select PedCath from its own program group.

Locating the Data Folder

If this is the first time PedCath has been run on this computer, a message box will appear, telling you that PedCath could not locate the Data Folder. Click OK and the Locate Data Folder screen will appear. Browse to locate your PedCath data files.

When you have located the proper directory, the red light above “Files Found” will turn from red to green. When the light is green, you are ready to proceed. Click OK.

Your Password

After you have located the data files, the PedCath login Screen will appear. Enter the user login and the password given to you by your network administrator.

The default password for new users is Taussig. Once you have used the password to login, you must change it immediately, and will be prompted to do so by PedCath.

Dr. Helen Brooke Taussig, often called the "mother of pediatric cardiology," was born in 1898. Dr. Taussig attended the medical school of Johns Hopkins University, where she became interested in cardiology. In 1930, she assumed leadership of the cardiology clinic at Johns Hopkins, where she encountered many "blue babies." She investigated the reasons for cyanosis and discovered that its major cause in cases of Tetralogy of Fallot was insufficient blood flow to the lungs.

Dr. Taussig was a pioneer in devising surgical treatments for congenital heart disease. In 1944, the Blalock-Taussig Shunt operation, which she developed with surgeon Dr. Alfred Blalock, was first performed. The publication of this procedure revolutionized the medical approach to congenital heart disease. It also inaugurated the new specialty of pediatric cardiology and led to the saving of many thousands of lives in the decades to come.

In later years, her failing hearing made Dr. Taussig rely increasingly on her sense of touch, using her hands to diagnose cases of congenital heart disease. Helen B. Taussig's contribution to pediatric cardiology was recognized through the bestowal of many honors, including the United States' Medal of Freedom, the French Chevalier Legion de la Legion d'Honneur, and the Italian Feltrinelli Prize. She died in 1986.
After you log in, PedCath opens to the browse screen, with snapshot views of every cath.

**The Browse Screen**

The patient list is located at the upper left part of the main screen. Each line shows a patient’s first and last names, and the hospital history number (MRN). The cath list, in the upper middle, shows cath records that have been saved for the selected patient. Each patient may have multiple cath records, which are identified in the list by date and the hospital’s cath number. To the right side of the screen is the staff list, which shows the personnel involved in each cath, as well as their roles.

The lower two thirds of the screen is devoted to a summary of the cath highlighted in blue in the cath list. On the left there are patient diagrams. In the middle are calculations derived from up to eight hemodynamic measurement sets. On the right are any diagnoses or procedures that accompany the present cath, along with their codes. Across the bottom are staff comments about the cath.

To view a patient’s caths, either click on the patient’s name, or use the arrow keys and the “Page Up” and “Page Down” keys to locate the desired patient’s record.

To view a larger version of the diagram, double click on it.

**Sorting patients**

When you start, you will notice a blue frame around the patient list. This indicates that the patient list is active. If you click on a cath record or staff record, the corresponding list will be highlighted.

Records may be sorted in ascending or descending order by clicking on the appropriate column heading. For example, to arrange patients by medical record number, click MRN in the gray box at the top of the patient list. A small arrow will appear next to MRN. To reverse the order, click in the same place again. Clicking on any of the gray field headings - Name, MRN, Cath Date, Cath No., Staff Name, or Role - will also provide quick sorting by field.

**Locating Patients**

When the patient list is sorted alphabetically, you may quickly jump to records with a specific beginning letter. For example, if the patient list is sorted by name, typing S will highlight the first patient whose last name begins with an “S.” Likewise, if the list is sorted by medical record number, typing 4 will highlight the first patient with a medical record number beginning with “4”.

For more detailed searches, there is a find function to locate a patient. To access this function, press Ctrl+F [hold down the Ctrl key, press F, then release both], click on the binoculars on the toolbar at the top of the screen, click on the Find button below the patient box, or select “Find…” from the tools menu. The find button will highlight the first patient it finds matching the search string you enter.

**Different views in the browse screen**

In the default view, cath records are sorted by patient. In addition, cath records may be viewed two other ways. In the View menu at the top of the main window, you may select to view caths by date or by staff.
The Browse Screen Toolbar

The toolbar is located at the top of the screen, just below the menus (File, Edit, View, Tools, and Help).

If you forget what a button does, you can find out by leaving the mouse over the button for a few seconds. A label will appear with the name of the button.

Editing patient demographics

Clicking the Edit Patient button or the Edit Patient icon will pop-up the Patient Record Window.

In this window, you may edit the patient name, MRN, Date of Birth, or gender. Any data you enter in this window will be automatically saved after you click OK.

Patient demographics may be edited by double clicking on the patient’s name.

Adding new patients

Clicking the Add Patient button or the Add Patient icon will pop-up an empty Patient Record Window.

Editing staff records

Clicking the View Personnel icon will pop up the staff list. Select a staff member and click View/Edit to make changes.

New staff may be added by those with administrator level access, under Tools-Options-Administrator-Personnel. You can also edit staff from the Browse screen by choosing View-Personnel.

Editing cath data

To edit an existing cath report; 1) click on the Edit Cath Report icon, 2) double click on the cath date in the cath list or 3) click the Edit Cath button below the cath list.

Adding a new cath

To create a new cath report; 1) click on the New Cath Report icon, or 2) click the New Cath button below the cath list.
The Edit Cath Screen

Demographic information
In the previous section we used a pop-up window to add and edit patient information. These same fields may also be edited in the top two lines of the Edit Screen.

Case information
The case information frame includes cath date and number; access notes, height and weight; as well as contrast and fluoroscopy data. The only required field is Cath Date.

Adding cath personnel and their roles
![Add personnel icon]
Add personnel to this cath by clicking on the Add Personnel to Cath Report icon.

![Delete personnel icon]
Delete personnel from this cath by clicking the corresponding row in the grid and clicking on the Remove Selected Person from Cath Report icon.

To change the role of the staff member, either double-click on the role, or click once and then click on the gray box on the right hand side of the field. A drop down list will appear with the roles at your hospital.
**Hemodynamic Sets**

You can use the Tab key to move logically through the data entry screen. Pressing Tab will move to the next field while Shift-Tab will move to the previous field. Try it!

Although the top half of the edit window stays the same for an entire cath report, the bottom half changes with each set of hemodynamic measurements. Up to eight hemodynamic sets can be associated with a single cath. The name of the set may be selected from the drop down box on the left hand side of the screen. This will contain common conditions that your hospital uses to gather hemodynamic data. You may also manually enter a condition by double-clicking this box and typing the name. Add or delete sets by clicking on the buttons below the set name. When deleting a set, a dialog box will pop up to confirm the deletion.

**Calculated values**

Calculated values are shown in the lower left-hand corner of the edit screen. Clicking the “View Calculations” button displays a window with all formulas and calculations displayed.

Any default value used in these calculations can be changed by clicking the Calculation Override button and changing the appropriate values in the window that appears (right).

**Oxygen consumption calculator**

You may enter a value for Oxygen Consumption, leave the field blank or you may use PedCath’s built in oxygen consumption calculations:

Assumed O2 by LaFarge method
The LaFarge method uses patient gender, age, and heart rate to calculate an assumed oxygen consumption. The LaFarge method is only available for patients between the age of 3 and 30.

Indexing a measured value:
If you use a measured value for oxygen consumption (ml/min), the calculator can use the stored value for Body Surface Area to compute an indexed value (ml/min/m²). When you open the calculator, the BSA value will automatically appear as the divisor for the oxygen consumption calculation. Patient height and weight are used to calculate BSA. **If height and weight data should change, you must re-calculate the value for oxygen consumption.**
**User Fields**

**PedCath** intentionally limits the number of reporting sites in the interest of brevity and clarity. Pressures and saturations not listed in the site grid can be reported in the comments section and/or added to the diagram.

**PedCath7** now offers eight additional sites. Four fields can be configured to store data on four additional sites for every cath performed in your lab. Also, four patient specific sites may be used to record sites specific to the current case.

**Measurements**

A new group of measured values is available in **PedCath7**. Review the default settings under **Tools>Options>Administrator>Calculations** to set global values for your institution.

**Qep**

**PedCath7** can calculate, display, and print QEP values. In the browser screen, go to **Tools>Options>User** and click on the calculate QEP checkbox to turn QEP calculations on or off.
PedCath Options

From the Browse Screen, select Tools>Options to open the options screen

General Tab
Allows the user to set guidelines for diagram previews, temporary file storage, and the destination folder for exported files.

User Tab
Options include calculation of QEP, whether or not to use smart name and/or date formatting, choice of the email address book, and whether or not to use the original or Anderson Mullins and Mayer Atlas nomenclature.

The user may also choose whether or not to preload default hemoset mappings or to use user mappings.

Finally, the user password may be changed under this tab.

Global Tab
Personnel roles may be added, deleted, or their rankings changed under this tab. Which staff roles will be included on the cath report and which will be authorized to lock a cath may also be determined here.

Administrator Tab
Administrative options under this tab include the editing of personnel information, guidelines for calculations, institutional sites for saturations, and import and export controls.

The Administrative Console may also be opened under this tab (see page 23), allowing the performance of database maintenance procedures.

In addition, guidelines for cath report locking, participation in collaborative studies, and the assignment of cath numbers (including the auto-increment feature) may be applied here.
**Overview**

**PedCath** has a wide array of export capabilities to externalize the cath report data once it is completed. You can configure **PedCath** to allow manual exports and/or automatic exports when a cath report is saved or locked in a variety of both visual and data-driven formats.

**Export Protocols**

**Files (Windows Sharing)** – You can save the **PedCath** report data to one of several file formats. When running automatic exports you can specify local or shared network locations for the file(s) to be saved to. See the next section for supported file formats.

**Print** – **PedCath** will allow you to print the report to a printer attached to your local computer or network. There are many options to configure what is printed on the report.

**FTP** – You can send the **PedCath** report in any file format via the File Transfer Protocol. This can be done both manually and automatically when a report is saved or locked. When configuring the FTP setup, you have the option to strip patient identifying data if the files are to be exported outside of your organization. SFTP is also supported (over SSH-2) and is recommended when sending data with patient identifying information to outside of your institution.

**Email** – We support any MAPI-enabled mail client and will load your default mail client with the **PedCath** PDF report as a mail attachment.

**Supported File Formats**

**HTML (.htm)** – **PedCath** can generate the report as a hypertext document that can be displayed within any web browser.

**TEXT (.txt)** – **PedCath** can export the report to a simple ASCII-format text file for simple parsing or backup.

**PDF (.pdf)** – **PedCath** also supports Adobe’s PDF document format. Files of this type have the advantage that they cannot be altered and preserve the original page layout when printed or viewed on different platforms. The PDF export has many configuration options that can be set during the report setup. This is the format **PedCath** uses for printing.

**Optional Formats**

**XML/XSL (.xml / .xsl)** – **PedCath** can write the report data in XML format, which is becoming the standard for data exchange between systems. We also export an XML stylesheet file (XSL) that presents the XML data in a web page format. If our PDF document or our XSL style sheet does not suit your needs for the printed report, your organization can develop its own XSL file to define the presentation of the XML data.

[http://www.w3.org/Style/XSL/](http://www.w3.org/Style/XSL/)

As of version 7.5.5, we have released version 2 of our XML format that is more inclusive of the report data and better suited for data exchange. Because it is written primarily for data exchange it does not currently include a style sheet for presentation.

You can configure which version to use in the export administrative options.

**HL7** – **PedCath** can write the report in the industry standard Health Level 7 format.(v2.3.1).
**Manual and Automatic Export**

**PedCath** allows you to configure which exports **PedCath** users may export manually and which ones will be automatically exported when the cath report is either locked or saved.

For manual exports you can also force the user to enter their user name and password before they can export.

For automatic exports the default path is set to the export folder within the **PedCath** network directory. Each user has the choice to use the default path or set it to a different location.

You can also define the file name format for the automatic exports by combining fields such as the MRN and cath number.
The six buttons (shown at right) launch (left to right) the comments, diagnoses and procedures, adverse events, and the diagram, image, and document managers.

**Comments**
Comments may be edited by selecting the comments button on the toolbar, pressing F2, or selecting “Comments…” from the view menu. This is the best place for short notes. For longer commentary, entire documents may be added to the report.

**Diagnoses and Procedures**
The diagnoses coding screen may be activated by selecting the Dx button on the toolbar, pressing Ctrl+D, or selecting Diagnosis and Procedures from the tools menu.

To add a code, you may either browse through the Code Set box or use a search facility.

In the Code Set box, expand the folder list by either double clicking on a folder or clicking on the + sign to the left of the folder you wish to open. Select a code by clicking on it. To see the full name of long descriptions, use the scroll bar at the bottom or leave the mouse over a description for a few seconds; in the latter case, the full name will appear momentarily. To add a code to the cath, use either the Add button or double click on the code.

To add a code via the Search for Code box, enter a code in the small text box on the left. If this box matches a code exactly, the code is displayed in the text box immediately to the right. Click Add to add this code to the cath. Notice the Copy List button to the right of the Selected Diagnoses and Procedures list. This will allow pasting of the selections under Comments or into another document.

You can add a code via the Search by Name box. Just enter a part of the name of the code for which you are searching. For example, entering *stra*, the selection box will list all diagnoses that contain the letters “stra” in order, such as “00105. Stradling mitral valve,” and “00106. Stradling tricuspid valve.”

Select Dx. codes by double clicking or highlighting and pressing the Add button.

You may remove a patient’s Dx. codes by highlighting them, then clicking the Remove button.

You can change the position (order of importance) of a selected code by highlighting it and then clicking the up and down arrows in the Rank box to the right.

Click the “Set Status Post” button to mark a procedure as status post. Procedures imported from earlier cases will automatically be set to status post. This option is not available for all coding sets.

**Adverse Events for MAGIC Users (Optional)**
For users participating in the MAGIC studies, an AE button is provided, which will open the Adverse Events screen. This will present the Adverse Events code list and relevant qualifiers.
Diagram Manager

To access the diagram manager, press F6, select “Diagram Manager…” from the Report menu, or click on the Diagram Manager button in the upper right of the edit screen.

In the Report Diagrams selection box in the upper left of this window, you may select the diagram you wish to view. A preview will appear on the right. Each diagram may be associated with between zero and four hemodynamic sets. Click the check boxes of the hem sets which you would like to associate with each diagram. To remove a diagram, click the button marked with an “X.” To add a new diagram, click on the Add Diagram button, the button marked with a folder on the far left of the toolbar.

Adding Diagrams

To add a diagram, expand the folder list by either double clicking on a folder or clicking on the + sign to the left of the folder you wish to open. Select a heart description by clicking on it; a small preview will appear on the right. To see the full name of long descriptions, use the scroll bar at the bottom of the folder list or leave the mouse over a description for a few seconds; in the latter case, the full name will appear momentarily.

Once you have chosen the diagram that best matches the patient, click the Select Diagram button at the bottom of the form, and the diagram will be added to the cath.

On the Other Diagrams tab you can create an additional atlas of diagrams for your institution. You can add diagrams to the User Atlas from a file or from the current patient’s template. To add the patient’s template to the User Atlas, click the Load Template button and then Add Template to Atlas. To load the template directly to the cath report, click the Load Template button and then the Select Diagram button.

We also provide a supplement to the Mullins and Mayer Atlas on our web site (www.pedcath.com) that can be added here. If you add a supplemental diagram you should enter the Mullins ID number which tells PedCath how measurements should be embedded.
**Editing Diagrams**

To edit a diagram, click on the pencil icon in the toolbar in the diagram manager or double click on the diagram you want to edit. This will activate the drawing screen.

The PedCath drawing program is specially designed to help you produce anatomical diagrams for your cath reports. The drawing tools are easy to use, and should look familiar to anyone who has used other Windows drawing programs. Hemodynamic data appears in a table next to the picture, allowing you to drag numeric values directly to the diagram.

*If you make extensive changes to the patient diagram, you may wish to save the diagram as a template by clicking the Save Template button. This option will save this diagram for this patient, allowing it to be recalled in the future. Each patient may have only one template.*

**Embedding Hemodynamic Values in the Diagram**

You may automatically embed all hemodynamic values from the data grid to the diagram. Values embedded in this way will appear at the appropriate places in the anatomy image, and will use the same automatic formatting features as when the same values are manually inserted. The Undo feature does not apply to embedded data; however, you may cancel an embed operation by closing the edit diagram screen without saving.

**Edit Diagram Toolbar**

The Edit Diagram toolbar contains options for adding various elements to a patient’s diagram: hemodynamic data and other text, as well as arrows, lines and shapes. Each element that you add to the diagram is called an object. Use one of the six drawing tools to add or edit objects on the diagram. Each of the tools has specific options, which are displayed below the toolbar.

**Undo Create Object**

Click this icon to undo the last drawing operation.

**Flush**

After you have added drawn objects to the diagram, they can be moved or edited individually until you either save the diagram or press the flush button. Although flushing does not save the diagram to the patient’s cath record, flushing the objects in the diagram makes them part of the diagram bitmap; they no longer exist as separate, editable elements. After an object has become part of the drawing, you can modify that object only by drawing over it.

**Selection Tool**

Use the selection pointer to select objects for editing or deletion. Only objects added to the diagram in the current editing session may be selected. After you have clicked the selection tool, the mouse pointer will change to a bull’s eye when it is over a selectable object. Click in the drawing on any object. A box will appear around it indicating that you may use one of the drawing tools to change it, or drag it to a new position on the diagram. To delete a selected object, press the Delete key. You may also select an object by right clicking on it with the mouse, even if you have not previously chosen the Selection Tool.
**Text Tool**

Choosing the text tool shows a text box where you may enter a string of characters to be placed on the diagram. Select a font and other formatting options, and then click on the diagram where you want the text to appear. If you click on any value in the hemodynamics tab, that figure will appear in the text box. You may format it as you would any text, and click on the diagram at the appropriate location. You may also pre-set the formatting options, and drag numbers onto the diagram with the mouse. Automatic formatting, such as the bar over mean values, will override your formatting when you use the drag and drop method.

**Freehand Tool**

Draw freehand lines and shapes using the freehand tool. Set the line color and thickness, and then drag the mouse on the diagram while holding down the left button.

*Drawing with any tool in white works as an eraser.*

**Line Arrow Tool**

Draw straight lines and arrows with the line tool. To draw a line, click at a starting position on the diagram and hold the mouse button down while you drag to the point where you want the line to end. Release the button to place the line on the diagram. Arrows are useful for indicating the catheter course. Select a size for the arrow’s head, and draw a line. You may place the arrowhead at the beginning or the end of the line.

**Rectangle, Ellipse, and Blob Tools**

Use one of the three shape tools to draw enclosed shapes on the diagram: (left to right) rectangles, ovals, or irregular shapes (blobs). For each of these shapes, set a Line Color for the outline, and a fill color for the enclosed, inside area. You may also select a fill pattern; for non-solid patterns, the transparent option will allow the diagram beneath your shape object to show through.

*Tip:* The blob tool is useful for drawing in stents by tracing an outline of each stent along the walls of an artery. Try using a diagonal crisscross Fill Style, and a transparent Fill Mode.
**Image Manager**

To activate the Image Manager, click on the camera icon in the Report Component Manager window. You can also launch the Image Manager by pressing F7 or selecting “Image Manager…” from the Report menu.

The image manager allows you to add images and captions to the cath record. To add an image, click on the folder icon in the image manager. A window will pop up allowing you to find and select an image to attach. A caption may be entered in the text box along the bottom of the image. To remove an image, click on the button with an “X,” just to the right of the Add Image button. When multiple images are associated with a cath, previews of the images are displayed along the left and right margins of the image manager window. To view an image in a larger size, click once on it, and the yellow cursor will surround the preview of the image.

To swap two images, click on one of the two images you would like to switch. Click on the third button from the left, and, following the on-screen instructions, click on the second image you would like to swap.

You can also import images directly from the Windows clipboard. These options will allow you to shrink the resolution or change the format of images currently in the database, or set up to have image modifications applied automatically during imports. This can be helpful to conserve disk space.

To edit an image select it within the Image Manager window and click the Edit Image button. The Image Editor (shown right) allows you to draw lines, shapes and text similar to how it is done in the in the Diagram Editor (see previous section for more details).
**Document Manager**

To show the document manager, press F8, select “Document Manager…” from the support menu, or click the Document Manager button from the upper right corner of the edit window.

The Document Manager enables you to import existing documents into the report or create new ones. You may also open, modify, and delete documents using the Document Manager.

When you click Import File, you may browse and select the document you wish to import. You may import documents in the following formats: *.rtf, *.txt, *.doc, *.htm, and *.html

Clicking Create New Document will open the Document Editor (below), which allows you to create documents containing tables and images.

There is a preview of the document that is currently selected in the lower left window. You can edit an existing document by clicking this window or by clicking the Edit File button.

The Document Manager also allows your institution to keep a Document Archive to pull related documents into the cath report (to be used as templates, for example). The documents listed within the My Cath Documents tab can be seen only by you, and those listed under Network Documents can be seen by all PedCath users. We provide over 20 documents for the institutional document archive to get you started. PedCath administrators can modify the hospital-wide archive.
**Edit Cath Report Screen Toolbar**

The six icons on the toolbar in the upper left of the Cath Report Screen (left to right) return to the Browse Screen, save changes, launch patient billing information, launch the report set-up, provide a print preview, and open help information.

---

**Billing Information**

To access patient billing information, press Ctrl+B, click the Patient Billing Information button on the toolbar, or select “Patient Billing Information” from the tools menu.

To add a code, you may either browse through the All codes box or use a search facility.

In the All codes box, expand the folder list by either double clicking on a folder or clicking on the + sign to the left of the folder you wish to open. Select a code by clicking on it. To see the full name of long descriptions, use the scroll bar at the bottom or leave the mouse over a description for a few seconds; in the latter case, the full name will appear momentarily. To add a code to the cath, use either the add button or double click on the code. If a code is added to the active cath through these methods or the others discussed below, it will be displayed as bold in the All codes box.

To add a code via the Search by Code box, enter a code in the small text box on the left. If this box matches a code exactly, the code is displayed in the text box immediately to the right. Click Add to add this code to the cath.

To add a code via the Search by Name box, enter a part of the name of the code for which you are searching. For instance, if you enter `sed`, the selection box below will contain any code name that contains the letters “sed” in that order, such as “Conscious Sedation, IV (99141),” and “Conscious Sedation, PO (99142).” Select the code that you wish to add and press the Add button.

In the “Codes for this Cath” box, you may change the number field by clicking the up and down arrows in the Count box to the right. You may also remove codes by clicking the remove button.

To add the -22 modifier to a billing item, select it and click the “-22” toggle button.
Locking the Cath Report

PedCath has the ability to lock the cath report so that no edits can be made. To lock the cath report, click the padlock toolbar button or choose “Lock Cath Report” from the File menu (shortcut Ctrl+L). In order to lock a cath you must be a staff member listed on the cath report with a role with lock privileges (Attendings only by default). Administrators can set the roles able to lock a cath report by choosing “Tools” > “Options…” from the Browse screen and clicking the Global tab.

These members also have the ability to unlock the report within the following 24 hours after a lock to make changes. To unlock the report choose “File” > “Unlock Cath Report” from the menu. After 24 hours this menu item will not be available and you will need to create an updated report described in the next section.

The staff member who locks the report is essentially saying the report is complete and thus signs off on it. The report printout will specify that this staff member signed the report.

Administrators can decide whether PedCath users can print preliminary reports and if so the text that will be printed on it to indicate that it is unsigned. To configure this option “Tools” > “Options…” > “Administrator” and click the “Report Locking” link.

Auto-export can be configured to trigger either when the cath is saved or when it is locked (default).

Creating Updated Reports

If it is required to make changes to the cath report after the grace period of 24 hours, PedCath will allow you to create an updated report to work from so that the original report will remain unaltered. To do this choose “File” > “Create Updated Report” from the menu. You are able to add, delete, or modify anything within the updated report including resources such as documents, images, and diagrams.

You can make as many updated reports as necessary and older updated reports or the original report can be viewed from the “View Backup Cath Report” item on the “File” menu. If you print an older report there will be a message on the printout saying that a newer report is available.

If the report you are editing or viewing is an updated report, a message will be shown in the status bar and a message will be printed on the report saying so.
Report Setup

To setup, preview, and print a cath report, press Ctrl+R, click the Report Setup button on the toolbar, or select “Report Setup…” from the Report menu. Reports can also be printed from the Browse screen in the same manner.

On the Components tab select the items you wish to include in the report. A check box is grayed if the associated cath component is not available for the current cath report. For instance, if there are no images, the Images check box is grayed; if you do not check the Documents check box in the Components box, each individual document’s check box will be grayed in the Documents box.

In the Images box, you may select the layout of the images.

On the Options tab you can select many report setup options such as page number location, and the caption to be used for diagrams, if any.

By clicking the “Diagram/Hemoset Options…” button you can specify which diagrams are to be printed and if summaries of all associated hemosets will be printed on each summary page or just one expanded set.

The “Dx/Comment Options…” will give you control over inclusion and positioning of the diagnoses, diagnoses’ comments, and cath comments. You can choose to roll the cath comments to the second page for instance, or choose to print the Dx comments rather than the Dx procedure list.

You may preview your report by clicking the Preview button.

When you are satisfied with the appearance and content of your cath report, press the Print Button and select the number of copies you wish to print.

You may also save the report in one of several formats; including ASCII, HTML, PDF, XML, or HL7. The PDF file will look the same as the printed report and uses the options set from the report setup. You can also email the PDF report by clicking the ‘Send…’ button, or manually send the report via one of the FTP profiles set by your institution.

You may optionally save your report settings so that the next time you go to print a report the settings will load the same way.
Data Reports

PedCath includes a data reporting tool that can be used to create reports based on criteria (query items) specified for your cath database. For example, a report could display all the caths where the patient was less than 7 days old, or list all the patients with Tetralogy of Fallot where Dr. Everett was the attending physician. Once the report query is run, the report will be created as a PDF document that can be printed, saved, or emailed.

Creating a Report Query

On the PedCath main screen (Browse screen), click the Tools menu and choose “Data Reports...” The “Data Report Utility” dialog will be displayed. Criteria may be entered here to filter for the desired records. PedCath will allow a search based on either patients or cath records and will display the fields chosen from the “Report Setup” dialog.

Let’s say we want to create a query for all cath records for patients less than 3 months old where Dr. Everett is the attending physician. In this case we would need to create two query items – one for Dr. Everett being the attending physician and the other specifying the age to be less than 3 months. To do this click the “New Item” button, expand the “Personnel Data” folder in the tree view, click on Dr. Everett’s name within the tree and press okay. Next select his role as “Attending” and press OK.

Follow the same procedure to add the query item for Age at Cath: Click “New Item”, select “Age at Cath” under the “Case Data” folder in the list box and click OK. Next select the age at cath to be less than 3 months and click OK. The screen should now look like the figure below.

Note: A query can be saved for future use by clicking the Save button, and a previously saved query can be loaded by clicking Load and finding the query file (p7q extension). Please note this file contains the query items and report setup but does not contain the results of running the report.
Before running the report query, click the “Report Setup” button on the “Data Report Utility” dialog. Within this dialog, the fields may be chosen that will be displayed on the report and what order they will be displayed in. The fields that are checked will be displayed on the report and the order can be changed by selecting the field name and clicking the up or down arrows.

It is important to specify whether the report is based on “Caths” or “Patients”. Choosing to search for caths will create a document displaying the case information for each matching cath record with the corresponding patient information following each record. A search based on patients will return a list of all the patients matching the query provided as well as their cath records.

Within the Performance group, you have the option to run queries across the network (default) or to run queries on a local copy of the database. Choosing the option to copy the files locally can greatly improve performance for complicated queries on slow networks. If you are planning on running a large number of queries it is recommended to run against a local copy. If you choose the ‘Copy tables locally’ option, you have the choice for PedCath to copy down the latest tables each time you run Data Reports or not.

Click Ok to save the report setup.
Running the Report Query

From the “Data Report Query” dialog, click “Create Report” to run the report query. Processing times can vary depending on the size of the cath database, complexity of the query, and speed of the network.

If we run the query entered in the previous sections on the sample data set, 2 cath are records are returned as shown in the figure below.

The “Layout” button will toggle the field labels on and off of the report. This dialog gives the option to preview, print, save, or email the report.
**Administrative Console**

The Administrative Console is a separate application from PedCath that contains many administrative features such as viewing login information, viewing access log information (HIPAA logging), running database maintenance and modifying the staff database.

You can start the Administrative Console from the start menu or within PedCath.

**To start from Windows:**
Start >> Programs >> PedCath >> Administrative Console
You will need to enter your PedCath initials and password to log in.

**To start from within PedCath:**
On the Browse screen choose:
Tools >> Options … >> Maintenance >> Run Administrative Console
You will be prompted to close PedCath if you plan on running the database maintenance utility.

**Editing Personnel**

The first tab contains the PedCath staff listing for your organization. Here you can add, remove, and modify staff members. The staff listing may be edited within PedCath as well (see the installation guide for more information on these options).

**Viewing HIPAA Logs**

On the second tab you can view HIPAA logging information such as when patients’ records were browsed or edited and by whom. This information can be seen by selecting a filtering option and clicking the “View HIPAA Log” button. For instance, to see a listing of when a particular patient’s cath information was viewed or edited click the “View by Patient” option and then the View HIPAA Log.

The View HIPAA Export feature works similarly except that it displays information related to exports and cath report locking. The last filter option “View by Export Action” is applicable to this feature and will allow you to search for a particular action type that happened, for instance a listing of all the cath reports printed.
**Maintenance**

The Maintenance table contains many features necessary to maintain the PedCath databases. The most important of these features is the Database Maintenance wizard which is described in the next section.

You can also set up database maintenance reminders within the Scheduled Maintenance grouping.

There are several options beneath the Other Maintenance group. These options are likely to be used rarely but are necessary in certain circumstances.

**Disconnect Data Folder** – This will remove the pointer to the PedCath database and it will have to be set the next time PedCath or the Administrative Console is run.

**Clear Version Data** – This will clear the version information from the database making it possible to revert to an earlier version of PedCath.

**Clear DB Version Data** – This will remove the database version number which will cause the database upgrade to run the next time PedCath is started. This can be helpful if the database upgrade needs to be run again or if you are reverting to an earlier version through a minor release (not recommended).

**Prompt for Code Set Sync** – This will cause PedCath to check for code set (Diagnosis/Procedure set and Billing) differences between the “master” set on the network and the sets that are used on the current workstation the next time PedCath is run.

**Configure Network Redirector** – This will allow you to set a database redirector to be used during database migration. All PedCath users who attempt to connect to the current path will be redirected to the new path you specify.

**Database Maintenance**

The Database Maintenance utility can be used to perform cleanup and integrity checks on your PedCath database. The picture to the right shows the maintenance options available. It is at least recommended to run the Indexes options which will rebuild the indexes in case they have become corrupted. The Integrity Check is recommended as well and will verify that the ID table is valid. Although unlikely, if you encounter an integrity error contact Scientific Software.

When records are deleted from a dbf table, the records are not actually removed but rather flagged for deletion. Under the Cleanup group checking the “Remove Deleted Records” option will actually remove all of these entries from these tables which will improve performance from smaller table sizes.

Checking for orphaned records will tell you if there are any cath records without a corresponding patient or any cath sub-table records without a corresponding cath record. You should rarely find many orphaned records. However, if you find a large number contact Scientific Software for assistance.

The final option “Remove All Record Locks” will remove all dBase internal record locks from the system as well as patient locks.
**Viewing Login Information**

The fourth tab allows you to see who’s logged into the system and what patients are currently being edited. If you select a staff member and click “Log Off User” the user’s login record will be removed and the user will not be able to edit any more cath reports. Note that the users will still be in the system and connected to the databases, so if you want to perform database maintenance they will need to close PedCath. You can also remove a patient lock from a user by selecting his name and clicking “Remove Patient Lock”. The selected user will not be able to save any changes to the current patient. These options are also helpful for single-user licensed institutions when, for instance, PedCath is terminated abnormally (such as by a system crash) and the login information is still present causing everyone to be locked out.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PedCath Formula Reference</strong></td>
<td>2</td>
</tr>
<tr>
<td>Body Surface Area—Dubois and Dubois height-weight equation</td>
<td>2</td>
</tr>
<tr>
<td>O₂ Capacity</td>
<td>2</td>
</tr>
<tr>
<td>MV, SA, PA and PV O₂ Content</td>
<td>2</td>
</tr>
<tr>
<td>Oxygen Consumption</td>
<td>3</td>
</tr>
<tr>
<td>Cardiac Output (Qp and Qs)</td>
<td>3</td>
</tr>
<tr>
<td>Resistance (Rp and Rs)</td>
<td>3</td>
</tr>
<tr>
<td><strong>HIPAA Technical Details for Administrators</strong></td>
<td>5</td>
</tr>
<tr>
<td>PedCath7 Logging</td>
<td>5</td>
</tr>
<tr>
<td><strong>The Diagnostic Code Set</strong></td>
<td>6</td>
</tr>
<tr>
<td>The standard PedCath code set – Summary</td>
<td>6</td>
</tr>
<tr>
<td>Optional Code Sets</td>
<td>6</td>
</tr>
<tr>
<td>Your Hospital’s Code set – List of codes</td>
<td>7</td>
</tr>
</tbody>
</table>
PedCath Formula Reference

Unless noted, references in this chapter are from the following texts:


**Body Surface Area—Dubois and Dubois height-weight equation**

Units: Weight in Kg, Height in cm (Yang et al, page 42.).

\[
BSA (cm^2) = Wt^{.425} \times Ht^{.725} \times 104
\]

Convert BSA (cm²) to BSA (m²):

\[
BSA (m^2) = \frac{BSA (cm^2)}{10000} = \frac{BSA (cm^2)}{100 \times 100}
\]

**O₂ Capacity**

The default factor is 1.36 (Yang et al, page 45.).

\[
O_2 \text{ Capacity} = HB \times 1.36
\]

PedCath uses 1.36 as the default multiplication factor for O₂ Capacity; however, the attending physician may set an alternate multiplier: 1.36 (default), 1.34 or 1.39.

The 1.39 multiplication factor is referenced in Saksena, page 30.

To change the multiplier, you must log in as an administrator and select:

Tools–Options–Administrator–Calculations.

**Multipliers are the responsibility of the cath lab medical director.**

**MV, SA, PA and PV O₂ Content**

Referenced as PO₂ x 0.003026 in Yang et al, page 45. PedCath rounds to 0.003.

a) If PO₂ not measured:

\[
O_2 \text{ Content} = O_2 \text{ Capacity} \times O_2 \text{ sat}
\]

b) If PO₂ measured:

\[
O_2 \text{ Content} = O_2 \text{ Capacity} \times O_2 \text{ sat} + (0.003 \times PO_2)
\]
Oxygen Consumption

Two different Oxygen Consumption calculations are available in PedCath:

a) Assumed Oxygen Consumption—LaFarge method

Please Note: This method can only be used for patients whose age and heart rate fall within defined limits. Data for gender, heart rate and age are required. Age is calculated as Cath date - Date of birth. O₂ consumption is calculated in (ml/min)/M². (LaFarge and Miettinen, pages 23-30.)

For Males:

\[ O_2 \text{ Consumption (ml/min/m}^2\text{)} = 138.1 \cdot \left(11.49 \times \log_e(\text{age in years})\right) + (0.378 \times (\text{heart rate})) \]

For Females:

\[ O_2 \text{ Consumption (ml/min/m}^2\text{)} = 138.1 \cdot \left(17.04 \times \log_e(\text{age in years})\right) + (0.378 \times (\text{heart rate})) \]

b) Indexing a measured value

If a measured value is available, use the Oxygen consumption Calculator to convert the measurement to an indexed value. The calculator uses the following formula:

\[ O_2 \text{ Consumption (ml/min/m}^2\text{)} = \frac{O_2 \text{ Consumption (absolute)}}{\text{BSA}} \]

Cardiac Output (Qp and Qs)

Cardiac Index Calculation (Yang et al, page 44):

\[ Qp \text{ (liters/min/m}^2\text{)} = \frac{O_2 \text{ Consumption (ml/min/m}^2\text{)}}{(PV - PA content) \times 10} \]

\[ Qs \text{ (liters/min/m}^2\text{)} = \frac{O_2 \text{ Consumption (ml/min/m}^2\text{)}}{(SA - MV content) \times 10} \]

Cardiac Output Calculation (Yang et al, page 45):

\[ Qp \text{ (liters/min)} = Qp \text{ (liters/min/m}^2\text{)} \times \text{BSA} \]

\[ Qs \text{ (liters/min)} = Qs \text{ (liters/min/m}^2\text{)} \times \text{BSA} \]

Resistance (Rp and Rs)

Wood’s Resistance Unit, also called Hybrid Resistance Unit (Yang et al, page 68): Wood’s Unit = mm Hg min. liter⁻¹ or [(mm Hg)/(liter/min.)]

(Pressures in mm Hg; Flow in liter/min./m²; Resistance in Wood’s Units.)

\[ Rp \text{ (indexed)} = \frac{\text{mean MPA} - \text{PA wedge}}{Qp} \quad \text{Rp (abs)} = \frac{Rp \text{ (indexed)}}{\text{BSA}} \]

\[ Rs \text{ (indexed)} = \frac{\text{mean Sys} - \text{mean RA}}{Qs} \quad \text{Rs (abs)} = \frac{Rs \text{ (indexed)}}{\text{BSA}} \]
New Calculations in PedCath7

PedCath7 offer several sets of calculations that were not part of the standard PedCath3 configuration. These new features can be found under the Measurements tab in the PedCath edit screen.

Ejection Fraction

\[ \text{Ejection Fraction (\%) } = \frac{\text{End Diastolic Volume} - \text{End Systolic Volume}}{\text{End Diastolic Volume}} \times 100 \]

PA Index (PAI)

\[ \text{PAI} = \pi \times \frac{\left( \frac{RPA}{2} \right)^2 + \left( \frac{LPA}{2} \right)^2}{\text{BSA}} \]

PA Area Index (PAAI)

\[ \text{PAAI} = \pi \times \frac{\left( \frac{RPA}{2} \right)^2 + \left( \frac{LPA}{2} \right)^2}{(279.89 \times \text{BSA}) \times 35.46} \]

References:

Thomas P. Graham, Jr., MD, Jay M. Jarmakani, MD, Ramon V. Canent, Jr., MD and Mary N. Morrow, AB; Left Heart Volume Estimation in Infancy and Childhood; Circulation, Volume XLIII, June, 1971

Thomas P. Graham, Jr., MD, Jay M. Jarmakani, MD, Gerald F. Atwood, MD, and Ramon V. Canent, Jr., MD; Right Ventricular Volume Determination in Children; Circulation, Volume XLVII, January, 1973

Scisuke Nakata, MD, Yasuharu Imai, MD, Yoshinori Takanashi, MD, Hiromi Kurosawa, MD, Kitsuhiro Tezuka, MD, Makoto Nakazawa, MD, Masahiko Ando, MD and Atsuyoshi Takao, MD; A new method for the quantitative standardization of cross-sectional areas of the pulmonary arteries in congenital heart disease with pulmonary blood flow; The Journal of Thoracic and Cardiovascular Surgery, Volume 88, Number 4, October 1984
**PedCath7 Logging**

PedCath7 tracks cath views and edits in compliance with the Health Insurance Portability and Accountability Act (HIPAA). When a user opens the PedCath Edit screen, PedCath will log information about the cath that was viewed, the staff member who viewed it and the date and time. If the staff member edits and saves the cath then PedCath will log this as well.

As of version 7.2.0, PedCath also logs anything exported from the system such as when any reports are printed, saved, or emailed. This includes the main PedCath report, a report from the data reporting module, the staff listing report, or a patient’s billing information.

The export log keeps track of the staff member, export date and time, and export location for each type of export. The following shows the types of export actions logged and additional information saved.

<table>
<thead>
<tr>
<th>Export Actions Logged</th>
<th>Additional information logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printed the PedCath report</td>
<td>Printer location</td>
</tr>
<tr>
<td>Saved the PedCath report to a file</td>
<td>Export location, file name</td>
</tr>
<tr>
<td>Emailed the PedCath report</td>
<td>Mail recipients (To: and CC:)</td>
</tr>
<tr>
<td>Printed data reports results</td>
<td>Query and printer location</td>
</tr>
<tr>
<td>Saved data reports results to a file</td>
<td>File name and query</td>
</tr>
<tr>
<td>Emailed data reports results</td>
<td>Mail recipients (To: and CC:) and query</td>
</tr>
<tr>
<td>Printed a patient’s billing information</td>
<td>Printer location</td>
</tr>
<tr>
<td>Printed a patient’s document</td>
<td>Document title, file name, and printer location</td>
</tr>
<tr>
<td>Printed the staff listing</td>
<td>Printer location</td>
</tr>
<tr>
<td>Exported a patient’s document</td>
<td>Document title and file name</td>
</tr>
<tr>
<td>Locked a cath report</td>
<td>none</td>
</tr>
<tr>
<td>Unlocked a cath report</td>
<td>none</td>
</tr>
<tr>
<td>Viewed a backup cath report</td>
<td>Backup ID</td>
</tr>
<tr>
<td>Submitted a study</td>
<td>Study name and study ID</td>
</tr>
<tr>
<td>Unlocked a study</td>
<td>Study name, study ID, and follow-up title if applicable.</td>
</tr>
<tr>
<td>Printed HIPAA log</td>
<td>Report description printer location</td>
</tr>
<tr>
<td>Ran batch export</td>
<td>Path, log file, export file type, total number of cases</td>
</tr>
</tbody>
</table>

PedCath logging data may be viewed from within the Administrative console on the “View HIPAA” tab.
The Diagnostic Code Set

**The standard PedCath code set – Summary**

If you choose, you may include codes in your PedCath cath reports to indicate cardiac and non-cardiac diagnosis, ECG findings, cath procedures, cath complications, surgery and pharmaceutical interventions.

The standard version of the program includes a set of codes developed for this purpose by Scientific Software Solutions and our medical advisors. We have found these codes to be complete, without burdening the user with excessive detail.

We are aware that no universally accepted set of codes exists for pediatric caths. Different institutions use different coding systems, and some do not use a coding system at all.

Our goal is to help you to do your work, your way. If you do not enter diagnosis codes, there will be no loss of functionality in PedCath. The list of codes simply will not appear in the printed report.

**Optional Code Sets**

If you wish to use an alternate code set, we can offer optional sets from some of the major pediatric hospitals. Currently, we have hierarchical coding systems available from the following institutions (all rights reserved by the developing institutions):

- **Hospital for Sick Children** – Toronto, Canada
- **Texas Children’s Hospital** – Houston, Texas
- **Boston Children’s Hospital** – Boston, Massachusetts

Please call Scientific Software Solutions if you need assistance in creating an optional code set for your hospital. We can provide limited technical assistance in testing code set compatibility, and may be available on a contractual basis to customize PedCath to your individual needs.

**It is important to select a code set before entering patient data.**

If you would prefer to use an optional code set, we recommend that you use it from the start. This will avoid any need to convert old patient records at a later date.

A complete listing of the Diagnostic Codes selected by your hospital follows this page.
Sample Reports

Your software comes with five sample cases that illustrate various features of PedCath.

It is recommended that you spend some time reviewing these examples and entering practice cases before logging actual data.

1. John Doe. This case illustrates a single cath with a single set of hemodynamics. Note that with a single set of hemodynamics, the Summary page includes additional information.

The following printing options have been selected:
   a) **Summary** is selected. This creates a one-page summary of the cath record, including an image of the diagram.
   b) **Expanded Calculations** is selected, generating a full-page listing of the all the calculations for the sample cath.
   c) **Measurements** box is checked, so the report includes a one-page summary of the optional measurements for the cath.
   d) **Full Page Diagram** is selected. The large diagram includes any embedded hemodynamic data.
   e) **Diagram Caption** is checked. Notice that the line “Arrows indicate catheter course” appears below the diagram on both the summary page and full-page diagram. Clicking the Options button in the lower right of the Cath Report Setup window may change the caption text.

2. John Deere. This case illustrates a single cath with two sets of hemodynamics. Since the Summary page includes more than one set of hemodynamic data, only the summary information is printed for each set. Full hemodynamic data can be printed on subsequent pages.

   Printing options:
   a) **Summary** is selected.
   b) The cath is then locked to prevent further editing.
   c) Later, the patient’s weight is corrected to 12.3 Kg.
   d) A second report is printed, with note that it had been modified.

3. Lotsa Oxygen. A single cath with two sets of hemodynamics—includes dissolved oxygen. If non-zero PO2 values are entered in the CALCULATION OVERRIDE window, dissolved oxygen is calculated.

   Printing options:
   a) **Summary**, **Expanded Calculations** and **Full-Page Diagram** are selected.
   b) **Documents** box is checked. The cath report narrative and letter to the referring physician are now included.
   c) Note text formatting used in the anatomy diagram. A bold font has been used in the diagram to accent values obtained on 100% O2.

4. Angela Plastie. This case illustrates the Image Manager feature.

   Printing options:
   a) **Summary** report is selected.
   b) **Images** report is also selected, showing before and after waveform and angio images.

5. Buck Rogers. This case illustrates a patient with two caths.
   In the BROWSE screen, patients with multiple caths will have those caths listed in reverse date order (i.e. from most recent cath at the top to earliest cath at the bottom).

   Printing options:
   a) Rogers’ first cath is printed with all print options except **Summary** and **Diagram Options** turned off, to produce a single page report.
Doe, John
MRN: 123456789012
Birth Date: 09/19/1995
Cath Date: 09/26/1996
Cath #: 95c-bb11
Age at cath: 12 months
Gender: Male
Attending: William Hammill, MD
Fellow: Sara E. Regan, MD
Referring: Dr. Kymberly Shackelford
Height: 85.0 cm  Weight: 9.5 kg
BSA = 0.47 m²
Fluoro: 16.00 min  Contrast: 12.00 mL
Vein: right femoral
Artery: right femoral

Diagnoses / Procedures
130. VSD, perimembranous
20. ASD, secundum
241. Respiratory disease

Comments
Left to right shunt, large
Right lung atelectasis

Example cath
Qp = 9.72 L/min (20.68 L/min/m²)
Qs = 2.59 L/min (5.51 L/min/m²)
Rp = 1.65 units (0.77 units x m²)
Rs = 21.22 units (9.97 units x m²)
Qp/Qs = 3.75 : 1  Rp/Rs = 0.08
Heart Rate: 121 bpm
VO2: 198 ml/min/m²
Hemoglobin: 8.8 gm/dL
Inspired O2: 21%
ph: 7.37
pCO2: 4.30
pO2: 83.0
HCO3: 25.0

Thermo CO:

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>67</td>
<td>SVC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>81</td>
<td>RA</td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>88</td>
<td>RV</td>
<td>50</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>89</td>
<td>PA</td>
<td>37</td>
<td>13</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>RPA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LPA</td>
<td>37</td>
<td>12</td>
<td>22</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>97</td>
<td>LA</td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>97</td>
<td>LV</td>
<td>95</td>
<td>10</td>
<td>8</td>
</tr>
<tr>
<td>97</td>
<td>aAO</td>
<td>95</td>
<td>39</td>
<td>57</td>
</tr>
<tr>
<td>97</td>
<td>dAO</td>
<td>97</td>
<td>40</td>
<td>61</td>
</tr>
</tbody>
</table>

IVC: O2%: 60
Mean: 6
Femoral Artery: O2%: 97
Sys/A: 99  Dias/V: 42  Mean: 63
L.U. Pulm. Vein: O2%: 97
Mean: 8
R.U. Pulm. Vein: O2%: 90
Mean: 7
Institut Cardiovasculaire Paris Sud
Institut Hospitalier Jacques Cartier
Cardiologie Pédiatrique
Cardiac Catheterization Laboratory

Example cath

Calculations:

\[ \text{O2 capacity} = \text{HB} \times 1.36 \]
\[ 11.97 = 8.8 \times 1.36 \]

\[ \text{MV O2 content} = (\text{O2 capacity} \times \text{MV sat}) \]
\[ 8.02 = (11.97 \times 0.67) \]

\[ \text{SA O2 content} = (\text{O2 capacity} \times \text{SA sat}) \]
\[ 11.61 = (11.97 \times 0.97) \]

\[ \text{PA O2 content} = (\text{O2 capacity} \times \text{PA sat}) \]
\[ 10.65 = (11.97 \times 0.89) \]

\[ \text{PV O2 content} = (\text{O2 capacity} \times \text{PV sat}) \]
\[ 11.61 = (11.97 \times 0.97) \]

\[ \text{Qp} = \text{O2 consumption} / ((\text{PV} - \text{PA content}) \times 10) \]

\[ \text{Qs} = \text{O2 consumption} / ((\text{SA} - \text{MV content}) \times 10) \]
\[ 5.51 \text{ L/min/m²} = 198 / ((11.61 - 8.02) \times 10) \]

\[ \text{Rp} = (\text{mean MPA} - \text{wedge}) / \text{Qp} \]
\[ 0.77 \text{ units x m²} = (25 - 9) / 20.68 \text{ L/min/m²} \]
\[ (\text{Wood’s units x Meters}^2) \]

\[ \text{Rs} = (\text{mean sys} - \text{mean RA}) / \text{Qs} \]
\[ 9.97 \text{ units x m²} = (61 - 6) / 5.51 \text{ L/min/m²} \]
\[ (\text{Wood’s units x Meters}^2) \]

Dissolved oxygen not calculated.

Values used:

\[ \text{MV sat} = 67 \]
\[ \text{PA sat} = 89 \]
\[ \text{Mean MPA} = 25 \]
\[ \text{Mean Sys} = 61 \]
\[ \text{HB} = 8.8 \]

\[ \text{PV sat} = 97 \]
\[ \text{SA sat} = 97 \]
\[ \text{Wedge} = 9.0 \]
\[ \text{Mean RA} = 6 \]
\[ \text{BSA} = 0.47 \text{ m²} \]

\[ \text{O2 consumption} = 198 \text{ mL/Min/m²} \]

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>67</td>
<td>SVC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>81</td>
<td>RA</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>88</td>
<td>RV</td>
<td>50</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>89</td>
<td>PA</td>
<td>37</td>
<td>13</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>RPA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LPA</td>
<td>37</td>
<td>12</td>
<td>22</td>
</tr>
</tbody>
</table>

Thermo CO:

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>97</td>
<td>LA</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>97</td>
<td>LV</td>
<td>95</td>
<td>10</td>
<td>57</td>
</tr>
<tr>
<td>97</td>
<td>aAO</td>
<td>95</td>
<td>39</td>
<td>57</td>
</tr>
<tr>
<td>97</td>
<td>dAO</td>
<td>97</td>
<td>40</td>
<td>61</td>
</tr>
</tbody>
</table>

IVC: O2%: 60
Mean: 6
Femoral Artery: O2%: 97
Sys/A: 99 Dias/V: 42 Mean: 63
L.U. Pulm, Vein: O2%: 97
Mean: 8
R.U. Pulm, Vein: O2%: 90
Mean: 7
Example cath

Ventricular Volume

<table>
<thead>
<tr>
<th></th>
<th>EDV</th>
<th>ESV</th>
<th>EF%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right</td>
<td>46.5</td>
<td>23.0</td>
<td>51%</td>
</tr>
<tr>
<td>Left</td>
<td>26.3</td>
<td>8.9</td>
<td>66%</td>
</tr>
</tbody>
</table>

Ventricular Mass

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>gm</td>
</tr>
<tr>
<td>20.0</td>
</tr>
</tbody>
</table>

PA Diameter

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>Right</td>
<td>10.3</td>
</tr>
<tr>
<td>Left</td>
<td>8.8</td>
</tr>
</tbody>
</table>

PA Index: 307
PA Area Index: 1.50

Valve Diameter

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>TV</td>
<td>18.0</td>
</tr>
<tr>
<td>MV</td>
<td>19.0</td>
</tr>
<tr>
<td>PV</td>
<td>15.0</td>
</tr>
<tr>
<td>AV</td>
<td>13.0</td>
</tr>
</tbody>
</table>

Doe, John

MRN: 123456789012
Birth Date: 09/19/1995
Cath Date: 09/26/1996
Cath #: 95c-bb11
Age at cath: 12 months
Gender: Male

Attending: William Hammill, MD
Fellow: Sara E. Regan, MD
Referring: Dr. Kymberly Shackelford

Height: 85.0 cm  Weight: 9.5 kg
BSA = 0.47 m²

Fluoro: 16.00 min  Contrast: 12.00 mL
Vein: right femoral
Artery: right femoral

Example cath

Qp = 9.72 L/min (20.68 L/min/m²)
Qs = 2.59 L/min (5.51 L/min/m²)
Rp = 1.65 units (0.77 units x m²)
Rs = 21.22 units (9.97 units x m²)
Qp/Qs = 3.75 : 1  |  Rp/Rs = 0.08

Heart Rate: 121 bpm
VO2: 198 ml/min/m²
Hemoglobin: 8.8 gm/dL
Inspired O2: 21%
pH: 7.37
pCO2: 43.0
pO2: 83.0
HCO3: 25.0

Thermo CO:

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>67</td>
<td>SVC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>81</td>
<td>RA</td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>88</td>
<td>RV</td>
<td>50</td>
<td></td>
<td>7</td>
</tr>
<tr>
<td>89</td>
<td>PA</td>
<td>37</td>
<td>13</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>RPA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LPA</td>
<td>37</td>
<td>12</td>
<td>22</td>
</tr>
</tbody>
</table>

Right

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>97</td>
<td>LA</td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>LV</td>
<td>95</td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>97</td>
<td>aAO</td>
<td>95</td>
<td>39</td>
<td>57</td>
</tr>
<tr>
<td>97</td>
<td>aAO</td>
<td>97</td>
<td>40</td>
<td>61</td>
</tr>
</tbody>
</table>

L.U. Pulm. Vein: O2%: 97
Mean: 8
R.U. Pulm. Vein: O2%: 90
Mean: 7
Arrows indicate catheter course.
Deere, John
MRN: 1234567
Birth Date: 01/05/1995
Cath Date: 09/24/1995
Cath #: 783
Age at cath: 8 months
Gender: Male
Attending: Matherne MD, Paul
Fellow: Heller MD, Felice
Referring:
Height: 82.0 cm  Weight: 11.4 kg
BSA = 0.49 m²
Fluoro: 16.00 min  Contrast: 45.00 mL
Vein: 5 French, LFV
Artery: 20 ga angiocath RFA

Pre-valvuloplasty
Qp = 2.85 L/min (5.82 L/min/m²)
Qs = 2.48 L/min (5.06 L/min/m²)
Rp = 2.28 units (1.12 units x m²)
Rs = 27.81 units (13.63 units x m²)
Qp/Qs = 1.15 : 1  Rp/Rs = 0.08

Post-valvuloplasty
Qp = 2.85 L/min (5.82 L/min/m²)
Qs = 2.85 L/min (5.82 L/min/m²)
Rp = 2.10 units (1.03 units x m²)
Rs = 23.83 units (11.68 units x m²)
Qp/Qs = 1.00 : 1  Rp/Rs = 0.09

Diagnoses / Procedures
85. Pulmonary Valve Stenosis
597. Balloon Pulmonary Valvuloplasty

Comments
Bicuspid pulmonary valve.
Moderate pulmonary insufficiency.
Hyperdynamic outflow tract.
No residual outflow tract gradient.

Arrows indicate catheter course.
Deere, John  
MRN: 1234567  
Birth Date: 01/05/1995  
Cath Date: 09/24/1995  
Cath #: 783  
Age at cath: 8 months  
Gender: Male  
Attending: Matherne MD, Paul  
Fellow: Heller MD, Felice  
Referring:  
Height: 82.0 cm  
Weight: 12.4 kg  
BSA = 0.51 m²  
Fluoro: 16.00 min  
Contrast: 45.00 mL  
Vein: 5 French, LFV  
Artery: 20 ga angiocath RFA  

Pre-valvuloplasty  
Qp = 2.97 L/min (5.82 L/min/m²)  
Qs = 2.58 L/min (5.06 L/min/m²)  
Rp = 2.19 units (1.12 units x m²)  
Rs = 26.72 units (13.63 units x m²)  
Qp/Qs = 1.15 : 1  
Rp/Rs = 0.08  

Post-valvuloplasty  
Qp = 2.97 L/min (5.82 L/min/m²)  
Qs = 2.97 L/min (5.82 L/min/m²)  
Rp = 2.02 units (1.03 units x m²)  
Rs = 22.90 units (11.68 units x m²)  
Qp/Qs = 1.00 : 1  
Rp/Rs = 0.09  

Diagnoses / Procedures  
85. Pulmonary Valve Stenosis  
597. Balloon Pulmonary Valvuloplasty  

Comments  
Bicuspid pulmonary valve.  
Moderate pulmonary insufficiency.  
Hyperdynamic outflow tract.  
No residual outflow tract gradient.  

** This report was modified from the original report, signed on 07/15/2005. **
Oxygen, Lotsa

MRN: 123
Birth Date: 01/01/2000
Cath Date: 05/22/2003
Cath #: 03c-0123
Age at cath: 3 years
Gender: Female
Attending: Allen D. Everett, MD
Fellow: Sara E. Regan, MD; Renee Friday, MD
Referring:
Height: 92.0 cm  Weight: 12.0 kg
BSA = 0.55 m²
Fluoro: 11.40 min  Contrast: 19.00 mL
Vein: Left Fem 5F
Artery: Right Fem 4F

Room Air Rest

Qp = 5.51 L/min (10.03 L/min/m²)
Qs = 1.60 L/min (2.90 L/min/m²)
Rp = 7.07 units (3.89 units x m²)
Rs = 31.95 units (17.57 units x m²)
Qp/Qs = 3.45 : 1  |  Rp/Rs = 0.22

100% oxygen by face mask

Qp = 38.21 L/min (69.47 L/min/m²)
Qs = 1.56 L/min (2.83 L/min/m²)
Rp = 0.92 units (0.50 units x m²)
Rs = 37.26 units (20.50 units x m²)
Qp/Qs = 24.55 : 1  |  Rp/Rs = 0.02

Diagnoses / Procedures
130. VSD, perimembranous
20. ASD, secundum
176. Secondary pulmonary hpn.
79. Persist. L SVC

Comments
1. Pulmonary vasculature responsive to oxygen therapy with an increase in the left to right shunt without a significant drop in pulmonary pressure.
2. Abnormal, but not stenotic mitral valve.
**Room Air Rest**

Calculations:

- **O2 capacity = HB x 1.36**
  
  \[17.95 = 13.2 \times 1.36\]

- **MV O2 content = (O2 capacity x MV sat)**
  
  \[9.69 = (17.95 \times 0.54)\]

- **SA O2 content = (O2 capacity x SA sat)**
  
  \[16.52 = (17.95 \times 0.92)\]

- **PA O2 content = (O2 capacity x PA sat)**
  
  \[15.44 = (17.95 \times 0.86)\]

- **PV O2 content = (O2 capacity x PV sat)**
  
  \[17.41 = (17.95 \times 0.97)\]

- **Qp = O2 consumption / ((PV - PA content) x 10)**

- **Qs = O2 consumption / ((SA - MV content) x 10)**
  
  \[2.90 \text{ L/min/m}^2 = 198 / ((16.52 - 9.69) \times 10)\]

- **Rp = (mean MPA - wedge) / Qp**
  
  \[3.89 \text{ units x m}^2 = (50 - 11) / 10.03 \text{ L/min/m}^2\]
  
  (Wood's units x Meters\(^2\))

- **Rs = (mean sys - mean RA) / Qs**
  
  \[17.57 \text{ units x m}^2 = (61 - 10) / 2.90 \text{ L/min/m}^2\]
  
  (Wood's units x Meters\(^2\))

**Dissolved oxygen not calculated.**

**Values used:**

- MV sat = 54
- PA sat = 86
- Mean MPA = 50
- Mean Sys = 61
- HB = 13.2
- PV sat = 97
- SA sat = 92
- Wedge = 11.0
- Mean RA = 10
- BSA = 0.55 m\(^2\)
- **O2 consumption = 198 mL/Min/m\(^2\)**

---

**Room Air Rest**

**Calculations:**

- **O2 capacity = HB x 1.36**
  
  \[17.95 = 13.2 \times 1.36\]

- **MV O2 content = (O2 capacity x MV sat)**
  
  \[9.69 = (17.95 \times 0.54)\]

- **SA O2 content = (O2 capacity x SA sat)**
  
  \[16.52 = (17.95 \times 0.92)\]

- **PA O2 content = (O2 capacity x PA sat)**
  
  \[15.44 = (17.95 \times 0.86)\]

- **PV O2 content = (O2 capacity x PV sat)**
  
  \[17.41 = (17.95 \times 0.97)\]

- **Qp = O2 consumption / ((PV - PA content) x 10)**

- **Qs = O2 consumption / ((SA - MV content) x 10)**
  
  \[2.90 \text{ L/min/m}^2 = 198 / ((16.52 - 9.69) \times 10)\]

- **Rp = (mean MPA - wedge) / Qp**
  
  \[3.89 \text{ units x m}^2 = (50 - 11) / 10.03 \text{ L/min/m}^2\]
  
  (Wood's units x Meters\(^2\))

- **Rs = (mean sys - mean RA) / Qs**
  
  \[17.57 \text{ units x m}^2 = (61 - 10) / 2.90 \text{ L/min/m}^2\]
  
  (Wood's units x Meters\(^2\))

**Dissolved oxygen not calculated.**

**Values used:**

- MV sat = 54
- PA sat = 86
- Mean MPA = 50
- Mean Sys = 61
- HB = 13.2
- PV sat = 97
- SA sat = 92
- Wedge = 11.0
- Mean RA = 10
- BSA = 0.55 m\(^2\)
- **O2 consumption = 198 mL/Min/m\(^2\)**

---

**Thermo CO:**

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>54</td>
<td>SVC</td>
<td>18</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>82</td>
<td>RA</td>
<td>18</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>86</td>
<td>RV</td>
<td>80</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>86</td>
<td>PA</td>
<td>75</td>
<td>30</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>RPA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LPA</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Right**

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Wedge</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**IVC:** O2%: 70

**Mean:** 7

Femoral Artery: O2%: 99

**Sys/A:** 108 Dias/V: 72 Mean: 80

**Left SVC:** O2%: 70

**Mean:** 8
100% oxygen by face mask

Calculated:

- O2 capacity = HB x 1.36
  17.95 = 13.2 x 1.36

- MV O2 content = (O2 capacity x MV sat) + (.003 x MV PO2)
  11.24 = (17.95 x 0.62) + (.003 x 38.0)

- SA O2 content = (O2 capacity x SA sat) + (.003 x SA PO2)
  18.24 = (17.95 x 0.98) + (.003 x 216.0)

- PA O2 content = (O2 capacity x PA sat) + (.003 x PA PO2)
  17.96 = (17.95 x 0.98) + (.003 x 121.0)

- PV O2 content = (O2 capacity x PV sat) + (.003 x PV PO2)
  18.24 = (17.95 x 0.98) + (.003 x 216.0)

- Qp = O2 consumption / ((PA - PV content) x 10)

- Qs = O2 consumption / ((SA - MV content) x 10)
  2.83 L/min/m² = 198 / ((18.24 - 11.24) x 10)

- Rp = (mean MPA - wedge) / Qp
  0.50 units x m² = (46 - 11) / 69.47 L/min/m²
                          (Wood's units x Meters²)

- Rs = (mean sys - mean RA) / Qs
  20.50 units x m² = (67 - 9) / 2.83 L/min/m²
                          (Wood's units x Meters²)

PO2:

- MV PO2 = 38.0
- PA PO2 = 121.0
- PV PO2 = 216.0
- SA PO2 = 216.0

Values used:

- MV sat = 62
- PA sat = 98
- Mean MPA = 46
- Mean Sys = 67
- HB = 13.2

- PV sat = 98
- SA sat = 98
- Wedge = 11.0
- Mean RA = 9
- BSA = 0.55 m²
- O2 consumption = 198 mL/Min/m²
RE: Status of Lotsa Oxygen  
MRN: 123  
Visit Date: 05/22/03  

Dear Dr. Neal,

I had the pleasure of taking care of your patient, Lotsa Oxygen today at the Virginia Children’s Heart Center in Charlottesville, Virginia. As you know, she is a 3 year-old determined by echocardiography to have atrial and ventricular septal defects and an abnormal mitral valve. For these reasons, she underwent cardiac catheterization to determine her present hemodynamics and anatomy.

At the time of her cardiac cath, she was angiographically and hemodynamically noted to have a large perimembranous type ventricular septal defect. She has a large left-to-right shunt, and systemic pulmonary artery pressures. Hemodynamic evaluation of her mitral valve did not demonstrate significant mitral stenosis although her mitral valve is abnormal anatomically.

Lotsa has a large ventricular septal defect associated with pulmonary hypertension and a large left-to-right shunt. Although her pulmonary artery pressures are elevated, her vascular bed is reactive to changes with oxygen. She is presently at significant risk of developing irreversible pulmonary vascular obstructive disease. We have recommended her for surgical repair at the earliest possible date by my surgical colleague, Dr. Shelby. Her care is being coordinated by Dr. Sing, the inpatient attending, who would be happy to discuss any details with you further. Thank you for allowing us to participate in the care of this child. If you have any questions in the interim, please feel free to call.

Sincerely,

Allen D. Everett, M.D.

ADE:jp
HISTORY

Lotsa Oxygen is a 3yo recently diagnosed by echocardiography with a ventricular septal defect, atrial septal defect and an abnormal mitral valve. She underwent cardiac catheterization to determine her present hemodynamics and anatomy.

PROCEDURE

The patient was sedated by the Pediatric Sedation Service. The patient was prepped and draped in the usual sterile fashion and both inguinal areas were infiltrated with 1% Xylocaine. Using percutaneous technique, a 5 French sheath was placed in the left femoral vein and a 4 French sheath in the right femoral artery. Through the arterial and venous sheaths, a right and transeptal left heart catheterization for congenital heart defects was performed. An innominate vein superior vena cava venogram was performed to demonstrate whether a left superior vena cava was present. A left ventricular cineangiogram was performed to demonstrate left ventricular function, size and the location and size of her ventricular septal defect. A right ventricular cineangiogram was performed to demonstrate the size of the right ventricle, patency of the tricuspid valve and the size of the pulmonary arteries. Hemodynamics were recorded both on room air and with 100% ambient oxygen. All catheters and sheaths were then removed, hemostasis was obtained by manual pressure and the patient returned to 7 West in stable condition.

ANGIOGRAPHIC DATA

1. An innominate vein venogram was performed in the AP projection. With injection, contrast was seen to fill a normal innominate vein with flow of contrast to a normal superior vena cava and right atrium. A left superior vena cava was present, draining via the coronary sinus to the right atrium.

2. A left ventricular cineangiogram was recorded in the RAO and LAO projections. With injection, contrast was seen to fill a finely trabeculated chamber that contracts well. With contraction, contrast was seen to flow across an unobstructed left ventricular outflow tract and immediately to opacify a large ventricular septal defect. The defect appears to be in the perimembranous location and is at least the size of the aortic root. The aortic arch is leftward.

3. A right ventricular cineangiogram was recorded in the AP and lateral projections. With injection, contrast was seen to fill a dilated, coarsely trabeculated chamber that contracts well. With contraction, contrast was seen to flow across an unobstructed right ventricular outflow tract and to opacify a dilated main pulmonary artery. The peripheral pulmonary vascular pattern appears grossly normal. On pulmonary venous recirculation, contrast was seen to return by normal pulmonary veins to the left atrium. There is obvious flow of contrast from the left atrium to the right atrium that even refluxes into the hepatic veins.

DISPOSITION

Lotsa has large atrial and ventricular septal defects with a large left-to-right shunt. She also has associated moderate to severe pulmonary hypertension that is only mildly improved with oxygen. I have forwarded this information to Dr. Johns, the inpatient attending who will be coordinating early surgical repair for Lotsa with our surgical colleague, Dr. Smith, in the next few days.

Allen D. Everett, MD
Attending
Pediatric Cardiology
ADE/jp  D: 05/22/03  T: 05/26/03
Plastie, Angela  
MRN: BB518  
Birth Date: 12/12/1998  
Cath Date: 02/28/1999  
Cath #: jj-19981  
Age at cath: 2 months  
Gender: Female  
Attending: Allen D. Everett, MD  
Fellow: Renee Friday, MD  
Referring:  
Height: 60.0 cm  
Weight: 4.0 kg  
BSA = 0.25 m²  
Fluoro: 7.00 min  
Contrast: 20.00 mL  
Vein: None  
Artery: 5F changed to a 6F  

Pre-Angioplasty  
Qp =  
Qs =  
Rp =  
Rs =  
Qp/Qs =   |  Rp/Rs =   
Heart Rate: 130 bpm  
VO2: 148 ml/min/m²  
Hemoglobin: 9.0 gm/dL  
Inspired O2: 21%  
ph: 7.44  
pCO2: 37.0  
pO2: 196.0  
HCO3: 24.0  
Thermo CO:  

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SVC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RPA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LPA</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>%O2</th>
<th>Site</th>
<th>Sys/A</th>
<th>Dias/V</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>99</td>
<td>dAO</td>
<td>56</td>
<td>43</td>
<td>50</td>
</tr>
</tbody>
</table>

Diagnoses / Procedures  
568. Balloon angioplasty AO  
672. Coarctation repair, SF  

Comments  
Coarctation of the aorta s/p subclavian flap repair with re-coarctation  
S/P balloon angioplasty with 6 and then 8 mm balloon.  
The stenosis measured 2mm, the transverse arch 6.5 mm and the decending aorta 7.75 mm  
Initial AAO to DAO gradient 80 mmHG, post angioplasty 15 mmHG  

Arrows indicate catheter course.
Aorta pre-angioplasty, gradient 80 mm

Aorta post-angioplasty, gradient 15 mmH

AAO & FA pressures, pre-angioplasty

AAO & FA pressures, post-angioplasty
Diagnoses / Procedures
112. Transposition of the Great Arteries
722. Arterial switch
86. Supravalvular Pulmonary Stenosis

Comments
Normal left ventricular function